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LIMITED WARRANTY

RGB Spectrum (RGB) warrants that this product will be free from defects in material and 
workmanship, under normal use and service, and when correctly installed and maintained, for a 
period of one (1) year from date of shipment. RGB’s liability under this warranty is limited solely to 
replacing, repairing or issuing credit for any product which is shown to be defective during the 
warranty period. 

Purchaser shall: (i) notify RGB Spectrum promptly in writing of any claims, and (ii) provide RGB 
Spectrum with an opportunity to inspect and test the product claimed to be defective. 

Warranty does not cover misuse, abuse, improper installation or application, improper 
maintenance or repair, alteration, accident or negligent use, improper temperature, humidity or 
other environmental condition during storage, transportation or handling. RGB Spectrum shall 
have no obligations under this warranty with respect to any defect unless it receives notice and a 
description of such defect no later than five (5) business days following the expiration of the 
warranty period.

THE WARRANTIES STATED HEREIN ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING (BUT NOT LIMITED TO) ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL RGB SPECTRUM BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES FOR LOSS, DAMAGE OR EXPENSE DIRECTLY OR 
INDIRECTLY ARISING FROM THE PURCHASER’S INABILITY TO USE THE PRODUCT 
EITHER SEPARATELY OR IN COMBINATION WITH ANY OTHER EQUIPMENT OR FACILITIES, 
OR FROM ANY OTHER CAUSE.

EXTENDED WARRANTY

An annual extended warranty may be purchased from RGB Spectrum. Should the product fail to 
operate properly during the covered period, RGB Spectrum will repair the product and restore it to 
normal operation without charge for labor and parts. For further information on obtaining an 
extended warranty, email tech@rgb.com or call (510) 814-7000.

IMPORTANT SAFETY INSTRUCTIONS

Thank you for your purchase of this quality RGB Spectrum product! To reduct the risk of fire, 
electric shock or product damage, please note the following: 

 Read these instructions.

 Keep these instructions.

 Heed all warnings.

 Install and use this apparatus in accordance with the manufacturer’s instructions.

mailto:tech@rgb.com
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 Do not expose this apparatus to rain or moisture. Do not place liquid-filled objects, such as 
vases, on the apparatus. 

 Do not block any of the ventilation openings.

 Do not install near any heat sources such as radiators, heat registers, stoves, or other 
apparatus (including amplifiers) that produce heat.

 Do not place any sources of open flames, such as candles, on the apparatus. 

 Clean only with a dry cloth.

 Do not defeat the safety purpose of the polarized or grounding type plug. A polarized plug has 
two blades with one wider than the other. A grounding type plug has two blades and a third 
grounding prong. The wide blade or the third prong is provided for your safety. When the 
provided plug does not fit into your outlet, consult an electrician for the replacement of the 
obsolete outlet.

 Unplug this apparatus during lightning storms or when unused for long periods of time.

 Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the apparatus. 

 Only use the attachments/accessories specified by the manufacturer.

 Refer all servicing to qualified service personnel. Servicing is required when the apparatus has 
been damaged in any way, such as power supply cord or plug is damaged, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped.

 Keep the packing material in case the equipment should ever need to be shipped.
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The RGB Spectrum QuadPlex is a high-performance multi-display processor that drives a single 
DisplayPort or HDMI video source on up to four HDMI displays. QuadPlex is available as either:

 A standalone unit (QPX DIN or QPX HIN).

 A PCIe card (QPX HIN-C or QPX DIN-C) installed in an RGB Spectrum Galileo or Zio W4000 
video wall processor.

Three buttons on the front of standalone QuadPlex units allow you to select the video source and 
output layout configuration, and view device information. Connecting a QuadPlex unit or PCIe card 
to a network and installing the QuadPlex application on a remote computer provides additional 
layout configuration options using an intuitive interface.

CHAPTER

1 INTRODUCTION
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QuadPlex provides these key features and functions:

1.1.1 System Features
 Drives up to four (4) displays simultaneously from a single source up to 4Kp60 resolution.

 Available with either a single DisplayPort 1.2 or a single HDMI 2.0 input port.

 Supports 7.1-channel audio. 

 The Layout button on standalone QuadPlex units allows you to select a variety of predefined 
display configurations.

 The QuadPlex application allows you to configure custom layouts as well as crop, upsample, 
or downsample content as needed. You may also rotate each output independently to support 
artistic wall configurations, and control and fine-tune dispay bezel corrections for seamless 
output.

 Supports multiple HDMI output resolutions up to 1900 × 1200 @60Hz. 

1.1.2 Inputs
 Standalone Units: Either 1 x DisplayPort 1.2 (QPX DIN) or 1 x HDMI 2.0 (QPX HIN).

 PCIe Cards: Either 1 x Mini DisplayPort 1.2 (QPX DIN-C) or 1 x Mini HDMI 2.0 (QPX HIN-C).

 HDMI or DisplayPort input supports input resolutions up to either 4Kp60 or 8K in one 
dimension.

 Supports High-definition Digital Content Protection (HDCP) to allow the display of protected 
content.

1.1.3 Outputs
 Up to either 4 x HDMI (standalone units) or 4 x Mini HDMI (PCIe cards).

 Supports multiple independent HDMI output resolutions up to 1900 × 1200 @60Hz.

 Supports High-definition Digital Content Protection (HDCP) to allow the display of protected 
content.

1.1.4 Control
 Easy-to-use controls located on the front panel (standalone QuadPlex units only). 

 A simple and intuitive QuadPlex remote configuration application.

1.1 Features and Benefits
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The Ethernet port provides system control for QuadPlex by connecting to either:

 A network.

 Directly to a PC.

This connection allows you control the system using the QuadPlex application installed on a 
remote PC.

This section describes the front and rear panel controls and indicators on a standalone QuadPlex 
unit.

1.3.1 Front Panel Controls and Indicators
Figure 1-1 shows the front panel controls and indicators on a standalone QuadPlex unit, and 
Table 1-1 describes them. 

Figure 1-1   Front Panel Controls and Indicators

1.2 System Control

1.3 Controls, Indicators, and Connectors (Standalone)

Table 1-1   QuadPlex Front Panel Controls and Indicators - Standalone 

ID Name Description

A LED A Along with LED B, displays unit status, as follows:
 Not lit: Unit is powered off.
 Green (solid): Unit is active.
 Green (slow blink): Unit is rebooting.
 Green (fast blink): Device is selected.
 Amber (solid): Firmware update in progress.
 Amber (slow blink): No network detected.
 Red (solid, along with LED B): Error.
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B LED B Along with LED A, displays unit status as follows:
 Not lit: Either the unit is off or has been selected.
 Green (solid): Unit is active with no errors
 Green (slow blink): Input or output signal does not match 

configuration.
 Amber (solid): No input signal detected.
 Amber (slow blink): Firmware update in progress.
 Red (solid, along with LED A): Error.
 Red (solid, only when a button is pressed): Buttons have 

been disabled.
If LED A and LED B both illuminate red, this indicates a fatal unit error. Try powering the QuadPlex unit off and on. If 
the LEDs are still red, then contact RBG Spectrum for support. See “Technical Support” on page 51.

1 Source Selection Selects the input source. The available options are:
 Video input
 Logo
 Nature background
 Bezel adjustment grid
 Red
 Green
 Blue
 Gray gradient

2 Layout Configuration Selects the layout. The currently-selected layout is highlighted in 
the list. The available layouts depend on the currently-installed 
firmware version and can be modified using the QuadPlex 
remote application.

Table 1-1   QuadPlex Front Panel Controls and Indicators - Standalone (Continued)

ID Name Description
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1.3.2 Rear Panel Controls and Indicators
Figure 1-2 shows the rear panel connectors on a standalone QuadPlex unit, and Table 1-2 
describes them.

Figure 1-2   Rear Panel Connectors

3 Device Information Shows the device information such as:
 Output ID (1, 2, 3, or 4).
 Model number.
 IP address.
 MAC address.
 If IP addressing is dynamic (DHCP) or static.
 Active layout.
 Input mode.
 Output mode.
 If bezel management is enabled.
 If HDCP is enabled.
 If there is an input mismatch between the configuration and 

the actual signal.
 If there is an output mismatch between the configuration 

and the actual display mode.
 Serial number.
 Firmware version.
 FPGA version.
 Whether or not the buttons are locked.

Table 1-1   QuadPlex Front Panel Controls and Indicators - Standalone (Continued)

ID Name Description

21 3

4 5

6
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This section describes the connectors a QuadPlex PCIe card.

1.4.1 Connectors and Indicators
Figure 1-3 shows the connectors and indicators on a QuadPlex PCIe card, and Table 1-3 
describes them.

Figure 1-3   Connectors and Indicators - PCIe Card

Table 1-2   QuadPlex Rear Panel Controls and Indicators - Standalone 

ID Name Description

1 Video input This will be either:
 HDMI 2.0 (QPX HIN)
 DisplayPort 1.2 (QPX DIN)

2 HDMI outputs Connect up to four HD monitors to these outputs.
3 LAN Connect this port to a network to use IP control. 
4 Network activity LED (green) Indicates network activity as follows:

 Not lit: No network activity detected.
 Green (fast blink): Network activity detected.

5 Network speed LED (amber) Indicates network speed as follows:
 Not lit: Speed below 1 Gbps
 Green (solid): Transmitting at 1 Gbps

6 Power connector Connect the 12VDC 3.5A power supply to this port.

1.4 Connectors (PCIe Card)

21 3

4 5
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This section provides the following specifications for QuadPlex standalone units and PCIe cards.

1.5.1 Standalone

Table 1-4 lists the specifications for a QuadPlex standalone unit.

Table 1-3   QuadPlex Connectors and Indicators - PCIe

ID Name Description

1 Video input This will be either:
 Mini HDMI 2.0 (QPX HIN-C)
 Mini DisplayPort 1.2 (QPX DIN-C)

2 Mini HDMI outputs Connect up to four HD monitors to these outputs.
3 LAN Connect this port to a network to use IP control. 
4 Network activity LED (green) Indicates network activity as follows:

 Not lit: No network activity detected.
 Green (fast blink): Network activity detected.

5 Network speed LED (amber) Indicates network speed as follows:
 Not lit: Speed below 1 Gbps
 Green (solid): Transmitting at 1 Gbps

1.5 Specifications

Table 1-4   QuadPlex Specifications - Standalone 

Parameter Description

Inputs

Video Inputs Either:
 1 x HDMI 2.0 (QPX HIN)
 1 x DisplayPort 1.2 (QPX DIN)

Color Sampling and 
Conversion

 RGB: 8;8;8 (24-bit)
 YUV: 4:4:4, 4:2:2 (8-bit)

Supported Resolutions  1920 × 4320 @ 60 Hz
 1920 × 4320 @ 30 Hz
 3840 × 2160 @ 30 Hz
 3840 × 2160 @ 60 Hz
 7680 × 1080 @ 30 Hz
 7680 × 1080 @ 60 Hz
 Other resolutions, on request

HDCP Compliant? Yes
Audio Embedded audio from HDMI or DisplayPort source

Outputs

Video Outputs 4 x HDMI Type A with 16-bit stereo L-PCM audio
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Supported Resolutions  1920 × 1080 @ 30Hz
 1920 × 1080 @ 60Hz
 1920 × 1200 @ 30Hz
 1920 × 1200 @ 60Hz
 Other resolutions, on request

Audio  1 x HDMI (embedded) or 1 x DisplayPort (embedded)
 PCM 7.1 or PCM stereo output format 

 
 

HDCP Compliant? Yes

Control

Command Protocols UPnP, HTTPS
Network 100/1000 Base-T RJ45 Ethernet port for control via the QuadPlex application
Buttons  Source Selection

 Layout Configuration
 Device Information 

Power

Power Supply  Input: Universal 100-240 VAC, 50-60 Hz
 Output: +12 VDC, 42 W, 3.5 A
 Output Connector: DIN 4 male (4-pin) with lock

Power Requirements +12 VDC, 3.5 A
Power Connector DIN 4 female (4-pin)
Power Consumption 15 Watts (maximum)

Environmental

Temperature  Operating (nominal): 32 ºF to 113 ºF (0 ºC to 45 ºC)
 Non-Operating: -40 ºF to 158 ºF (-40 ºC to 70 ºC)

Relative Humidity  Operating: 20% to 80% non-condensing
 Non-Operating: 5% to 95% non-condensing

Altitude (Operating)  Maximum: 9,842 feet (3 km)
 Minimum: 0 feet (0 m)

Altitude (Non-Operating  Maximum: 39,370 feet (12 km)
 Minimum: -164 feet (-50 m)

Physical

Type Standalone appliance
Form Factor 1RU, third width
Memory 1 GB

Table 1-4   QuadPlex Specifications - Standalone (Continued)

Parameter Description
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1.5.2 PCIe Card
Table 1-4 lists the specifications for a QuadPlex PCIe card.

Dimensions 5.50” x 1.25” x 7.13” 
(13.97 cm x 3.18 cm x 18.11 cm)

Regulatory Compliance Class A: RCM, CE, FCC, KC
Specifications are subject to change without notice.

Table 1-5   QuadPlex Specifications - PCIe Card 

Parameter Description

Inputs

Video Inputs Either:
 1 x Mini HDMI 2.0 (QPX HIN-C)
 1 x Mini DisplayPort 1.2 (QPX DIN-C)

Color Sampling and 
Conversion

 RGB: 8;8;8 (24-bit)
 YUV: 4:4:4, 4:2:2 (8-bit)

Supported Resolutions  1920 × 4320 @ 60 Hz
 1920 × 4320 @ 30 Hz
 3840 × 2160 @ 30 Hz
 3840 × 2160 @ 60 Hz
 7680 × 1080 @ 30 Hz
 7680 × 1080 @ 60 Hz
 Other resolutions, on request

HDCP Compliant? Yes
Audio Embedded audio from HDMI or DisplayPort source

Outputs

Video 4 x Mini HDMI Type C with 16-bit stereo L-PCM audio
Supported Resolutions  1920 × 1080 @ 30Hz

 1920 × 1080 @ 60Hz
 1920 × 1200 @ 30Hz
 1920 × 1200 @ 60Hz
 Other resolutions, on request

Audio  1 x HDMI (embedded) or 1 x DisplayPort (embedded)
 PCM 7.1 or PCM stereo output format

HDCP Compliant? Yes

Control

Command Protocols UPnP, HTTPS
Network 100/1000 Base-T RJ45 Ethernet port for control via the QuadPlex application

Table 1-4   QuadPlex Specifications - Standalone (Continued)

Parameter Description
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Power

Power Consumption 15 Watts (maximum)

Environmental

Temperature  Operating (nominal): 32 ºF to 113 ºF (0 ºC to 45 ºC)
 Non-Operating: -40 ºF to 158 ºF (-40 ºC to 70 ºC)

Relative Humidity  Operating: 20% to 80% non-condensing
 Non-Operating: 5% to 95% non-condensing

Altitude (Operating)  Maximum: 9,842 feet (3 km)
 Minimum: 0 feet (0 m)

Altitude (Non-Operating  Maximum: 39,370 feet (12 km)
 Minimum: -164 feet (-50 m)

Physical

Type PCIe card (x1 electrical, x16 mechanical-power only)
Form Factor Full Height
Memory 1 GB
Dimensions 0.85” x 5.00” x 6.21” 

(2.16 cm x 12.70 cm x 15.77 cm)
Regulatory Compliance Class A: RCM, CE, FCC, KC
Specifications are subject to change without notice.

Table 1-5   QuadPlex Specifications - PCIe Card (Continued)

Parameter Description
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This chapter describes the QuadPlex installation process in the following sections:

 “Mounting a QuadPlex Standalone Unit” on page 11.

 “Connections (Standalone Unit)” on page 14.

 “Connections (PCIe Card)” on page 17.

 “Powering On” on page 19.

This section describes how to mount one or more standalone QuadPlex units in a variety of ways.

2.1.1 Rack Mount
The optional rack mounting shelf (p/n QPX RAK) allows you to mount up to three (3) horizontal 
QuadPlex units in a 1RU space or 10 vertical QuadPlex units in a 3RU space. See Figure 2-1.

Figure 2-1   Rack Mounting Shelf

CHAPTER

2 INSTALLATION

2.1 Mounting a QuadPlex Standalone Unit
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H O R I Z ON TA L

To horizontally mount up to three (3) QuadPlex units on the rack mounting shelf:

1. Fasten the shelf to the rack in accordance with the instructions for your rack. The shelf 
includes screws that are compatible with most rack mounts. If needed (such as for clearance), 
you may mount the QuadPlex unit(s) first, and then mount the shelf and units to the rack.

2. Remove the four (4) rubber pads at the bottom of each QuadPlex unit that you are going to 
mount.

3. On the rack mounting shelf, locate the three sets of mounting holes labeled M/M. These holes 
are 2” (5.08 cm) from the front edge of the mounting shelf.

4. Place the first QuadPlex unit on the rack mounting shelf, being sure to line the mounting holes 
on the bottom of the casing with one of the sets of holes labeled M/M.

5. Secure the QuadPlex unit to the rack mounting shelf using two (2) M3 x 6 flat-head screws 
(included in the rack mounting kit) and a hand screwdriver. Do not over-tighten the screws.

6. Repeat Steps 3-5 for up to two (2) more QuadPlex units.

7. Connect the input, output, network, and power cables to the mounted unit(s), as described in 
“Connections (Standalone Unit)” on page 14.

V E R T I C A L

To vertically mount up to 10 QuadPlex units on the rack mounting shelf:

1. Fasten the shelf to the rack in accordance with the instructions for your rack. The shelf 
includes screws that are compatible with most rack mounts. If needed (such as for clearance), 
you may mount the QuadPlex unit(s) first, and then mount the shelf and units to the rack.

2. On the rack mounting shelf, locate the 10 sets of mounting holes labeled M. These holes are 
1.25” (3.18 cm) from the front edge of the mounting shelf.

3. Place the first QuadPlex unit on the rack mounting shelf, being sure to line the mounting holes 
on the side of the casing with one of the sets of holes labeled M.

4. Secure the QuadPlex unit to the rack mounting shelf using two (2) M3 x 6 flat-head screws 
(included in the rack mounting kit) and a hand screwdriver. Do not over-tighten the screws.

5. Repeat Steps 3-5 for up to nine (9) more QuadPlex units.

I m p o r t a n t

When rack-mounting one or more QuadPlex units:
 Never stack anything directly over the unit(s).
 Make sure that all cables are properly secured and that no tension is applied to them.
 Make sure that the ambient air temperature does not exceed the maximum listed in 

Table 1-4.
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6. Connect the input, output, network, and power cables to the mounted unit(s), as described in 
“Connections (Standalone Unit)” on page 14.

2.1.2 VESA Mount
You can mount QuadPlex units on standard 75 mm, 100 mm, or 200 mm VESA mounts, or on the 
back of devices with VESA-compliant mounting holes. The optional angle bracket kit (p/n 920 
12325) includes two (2) brackets and mounting screws.

7 5 - 1 0 0  M M

To mount a QuadPlex unit on a 75 or 100 mm 
mounting space:

1. Attach the brackets to the VESA mount 
using two (2) M4 screws (sold separately) 
inserted through a slot in each bracket, as 
shown in Figure 2-2. Do not over-tighten.

2. Use four (4) M3 x 6 flat-head screws 
(included in your kit) to attach the QuadPlex 
unit to the brackets. Do not over-tighten.

Figure 2-2   75 or 100 mm VESA Mount

2 0 0  M M

To mount a QuadPlex unit on a 200 mm 
mounting space:

1. Use four (4) M3 x 6 flat-head screws 
(included in your kit) to attach the QuadPlex 
unit to the brackets with the angles facing 
away from each other, as shown in 
Figure 2-3. Do not over-tighten.

2. Attach the brackets to the VESA mount 
using two (2) M4 screws (sold separately) 
inserted through a slot in each bracket. Do 
not over-tighten.

Figure 2-3   200 mm VESA Mount

No t e Each VESA mount can only accommodate a single device. If you use a VESA mount for a 
QuadPlex unit, that mount cannot be used to attach a second device.



RGB

C H A P T E R  2
I ns t a l l a t i on

14 QuadPlex User Guide 350-12336-01 – updated April, 2020

This section describes how to connect a standalone QuadPlex unit to: 

 A video source.

 Up to four displays.

 Your network.

 Power supply.

2.2.1 Connecting the Source
Connect one of the following video sources to 
your QuadPlex unit, as appropriate:

 QuadPlex QPX DIN: Connect a single 8K 
UHD, 4K UHD, or 2K/HD DisplayPort 
source to the DisplayPort IN port.

Figure 2-4   DisplayPort Input - Standalone

 QuadPlex QPX HIN: Connect a single 8K 
UHD, 4K UHD, or 2K/HD HDMI source to 
the HDMI IN port. For DVI sources, you use 
a DVI-to-HDMI cable or adapter.

Figure 2-5   HDMI - Standalone

2.2 Connections (Standalone Unit)

No t e See “Connections (PCIe Card)” on page 17 for instructions on connecting a QuadPlex 
PCIe card.

No t e If needed, you may use Mini DisplayPort to DisplayPort adapters (p/n 520 12178; sold 
separately) and/or Mini HDMI to HDMI adapters (p/n 520 12233; sold separately).

I m p o r t a n t Use only DisplayPort 1.2 and/or HDMI 2.0-compatible “Premium Certified”, high-bandwidth 
cables to connect the video source and displays.

I m p o r t a n t
Always press the latch on the top of 
the DisplayPort connector when 
removing the connector.
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2.2.2 Connecting Displays
To connect displays to the QuadPlex unit, 
connect up to four (4) 2K/HD displays to the 
HDMI OUT ports.

Figure 2-6   HDMI Outputs - Standalone

2.2.3 (Optional) Securing the Cables - Standalone
If desired, you may secure the input and output 
cables to the standalone QuadPlex unit using 
the following brackets, sold separately:

 Single HDMI bracket: Part number QPX 
BRK-1H, if you are using a QPX HIN unit. 
This bracket is not used with the QPX DIN.

 Quadruple HDMI bracket: Part number 
QPX BRK-4H. Secures the HDMI output 
cables.

Figure 2-7   Securing the HDMI Cables - Standalone

To secure the cables to the stadalone QuadPlex unit:

1. Fasten two screw post extenders (1) to the threaded holes on either side of the HDMI OUT 
ports.

2. Place the QPX BRK-4H HDMI cable bracket (2) over HDMI the cables, and then slide it toward 
the QuadPlex unit until it touches the screw post extenders.

3. Secure each end of the QPX BRK-4H 
HDMI cable bracket to the screw post 
extenders using two (2) 2 9/16” (6.51 cm) 
screw posts. Do not use 1 15/16” (4.92 cm) 
screw posts.

4. If you are using an HDMI standlone 
QuadPlex unit (p/n QPX HIN), then secure 
the HDMI input cable to the port using a 
single screw post extender (1), QPX BRK-
1H (2), and a single 2 9/16” screw post (3).

Figure 2-8   Securing the HDMI Input - Standalone

No t e

The overmold (or boot) of each 
HDMI connector must be no more 
than the 0.823” (20.9 mm) width 
and 0.452” (11.5 mm) thickness 
stated in the HDMI specifications.

1

2

3

2

1

3
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2.2.4 Connecting to a Network
Use a standard Cat 5, 5e, 6, or 7 network cable 
with an RJ-45 plug to connect a control PC, 
network hub, router, or gateway to the LAN port 
on the QuadPlex unit.

Figure 2-9   Ethernet Connection- Standalone

2.2.5 Connecting Power
Connect the 12 VDC cable from the QuadPlex 
power supply to the DIN POWER port on the 
back of the QuadPlex unit.

Figure 2-10   Power Connection - Standalone

I m p o r t a n t
Always press the latch on the top of 
the Ethernet connector when 
removing the connector.

I m p o r t a n t

Never pull on the power cable to 
disconnect the power connector. 
Always grasp the connector firmly, 
slide the connector back, and then 
carefully remove the power cable.
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This section describes how to connect a QuadPlex PCIe card: 

 A video source.

 Up to four displays.

 Your network.

2.3.1 Connecting the Source
Connect one of the following video sources to 
your QuadPlex PCIe card, as appropriate:

 QuadPlex QPX DIN-C: Connect a single 
8K UHD, 4K UHD, or 2K/HD Mini 
DisplayPort source to the DisplayPort IN 
port.

Figure 2-11   DisplayPort Input - PCIe Card

 QuadPlex QPX HIN-C: Connect a single 
8K UHD, 4K UHD, or 2K/HD mini HDMI 
source to the HDMI IN port. For DVI 
sources, use a DVI-to-HDMI cable or 
adapter.

Figure 2-12   HDMI Input - PCIe Card

2.3 Connections (PCIe Card)

No t e See “Connections (Standalone Unit)” on page 14 for instructions on connecting a 
standalone QuadPlex unit.

No t e If needed, you may use Mini DisplayPort to DisplayPort adapters (p/n 520 12178; sold 
separately) and/or Mini HDMI to HDMI adapters (p/n 520 12233; sold separately).

I m p o r t a n t Use only DisplayPort 1.2 and/or HDMI 2.0-compatible “Premium Certified”, high-bandwidth 
cables to connect the video source and displays.

I m p o r t a n t Always press the latch on the top of the DisplayPort connector when removing the 
connector.
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2.3.2 Connecting Displays
Connect up to four (4) 2K/HD mini HDMI 
displays to the HDMI OUT ports.

Figure 2-13   HDMI Outputs - PCIe Card

2.3.3 (Optional) Securing the Cables - PCIe
If desired, you may secure the input and output 
cables to the QuadPlex PCIe card using up to 
five (5) QPX BRK-1H brackets. These brackets 
and corresponding screw posts are sold 
separately as a 5-pack (p/n QPX BRK-5DH) 
that is suitable for both the QPX DIN-C and 
QPX HIN-C cards.

Figure 2-14   Securing the Cables - PCIe

To secure the cables to the QuadPlex PCIe 
card:

1. Fasten a single screw post extender to 
each of the five threaded holes on the card next to each input/output port.

2. Place a QPX BRK-1H cable bracket over a cable, and then slide it toward the QuadPlex PICe 
card until it touches the screw post extender.

3. Secure the bracket to the screw post extender using a single 2 9/16” (6.51 cm) screw post. Do 
not use a 1 15/16” (4.92 cm) screw post.

4. Repeat Steps 2-4 for the remaining cables that are connected to the QuadPlex PCIe card.

No t e

The overmold (or boot) of each 
HDMI connector must be no more 
than the 0.551” (14 mm) width and 
0.331” (8.4 mm) thickness stated in 
the HDMI specifications.
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2.3.4 Connecting to a Network
Use a standard Cat 5, 5e, 6, or 7 network cable 
with an RJ-45 plug to connect a control PC, 
network hub, router, or gateway to the LAN port 
on the QuadPlex PCIe card. The QuadPlex 
PCIe card have its own dedicated Ethernet 
conection in addition to the other Ethernet 
connection(s) used by the host Galileo or Zio 
W4000 device.

Figure 2-15   Ethernet Connection - PCIe Card

2.4.1 Standalone Unit
To power on a QuadPlex standalone unit:

1. Turn on your output display(s). 

2. Turn on the video source component. 

3. Plug the female end of the supplied power cord into the AC power inlet at the rear of the 
QuadPlex (AC 100V ~ 240V). 

4. Connect the other end to an AC power source. 

LED A and LED B illuminate solid green. 

Your QuadPlex standalone unit is now ready for use.

2.4.2 PCIe Card
To power on a QuadPlex PCIe card:

1. Turn on your output display(s). 

2. Turn on the video source component. 

3. Turn on the Galileo or Zio W4000 device that contains the QuadPlex card(s) and wait for the 
device to boot.

Your QuadPlex PCIe card is now ready for use.

I m p o r t a n t Always press the latch on the top of the Ethernet connector when removing the connector.

2.4 Powering On

I m p o r t a n t Turn on the input source and output display(s) before turning on the QuadPlex unit or PCIe 
card to ensure proper display detection.
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All QuadPlex devices are configured as follows:

 Standalone unit:

 Receives power from the external power supply.

 Is controlled by the QuadPlex application that is installed on a remote PC.

 PCIe card:

 Receives power from the Galileo or Zio W4000 device in which it is installed.

 Requires its own Ethernet connection that is separate from and in addition to the Galileo 
or Zio W4000 Ethernet connection. 

 Is controlled by the QuadPlex application that is installed on a remote PC. You cannot 
control a QuadPlex PCIe card from the Galileo or Zio W4000 device that includes that 
card.

 IP address: By default, QuadPlex devices receive IP address assignments via Dynamic Host 
Control Protocol (DHCP). You may configure QuadPlex devices to use static IP addresses.

 Multiple subnet support: All QuadPlex devices within the same subnet are detected using 
the Universal Plug and Play (UPnP) protocol. Devices installed across multiple subnets must 
be verified on a subnet-by-subnet basis.

 Firmware: Be sure to update the formware on your QuadPlex device(s) before use, as 
described in “Firmware Updates” on page 47. 

This section describes the QuadPlex application system requirements, and then guides through 
installing the software on a remote PC.

2.6.1 System Requirements
The remote PC on which you are installing the QuadPlex application must meet all of the following 
requirements:

 Operating System: Windows® Server® 2019, Windows® Server® 2016, Windows® 10 
Standard (64-bit), Windows® 10 Professional (64-bit), Windows® 10 Enterprise (64-bit), or 
Windows® 10 IoT.

 Network: The remote PC must be connected to the same subnet as the QuadPlex device(s) 
that it will be controlling, and those devices must be reachable from the host PC.

 Rights: You may need administrator rights to install or uninstall certain software. See your 
Windows documentation or contact your system administrator for assistance, if needed.

2.5 Configuration

2.6 Installing the QuadPlex Application
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2.6.2 Installation
To install the QuadPlex application on the remote PC:

1. Connect and power on your QuadPlex devices, and then verify that all devices have been 
discovered by the network. If needed, contact your network administrator for help.

2. Verify that all of the QuadPlex devices can by reached from the remote PC by opening a 
command prompt and then executing a ping <device_ip_address> command for each 
QuadPlex device, where <device_ip_address> is the IP address of either a standalone 
QuadPlex unit or a QuadPlex PCIe card.

3. Either download the QuadPlex.msi installer to the remote PC or insert a drive containing this 
file into the remote PC.

4. Double-click the installer icon.

The Welcome window appears.

5. Click Next.

The End-User License Agreement window appears.

6. Read the license, then check the I accept the terms... checkbox, and then click Next.

The Destination Folder window appears.

7. Decide whether or not to create a desktop shortcut for the application by either checking or 
clearing the Do you want to create a Desktop shortcut? radio button, and then either:

 Click Next to accept the default installation folder.

 Enter a new path to a custom installation folder in the field, and then click Next.

 Click Change to browse to the desired installation folder, and then click Next.

The Ready to install QuadPlex window appears.

8. Either:

 Click Install to finish the installation.

 Click Back to go back to review/change your installation settings.

 Click Cancel to exit without installing the QuadPlex application.
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This chapter describes how to control your standalone and/or PCIe QuadPlex device(s) by:

 “Using the Buttons” on page 23.

 “Using the QuadPlex Application” on page 24.

 This chapter also describes some of the many screen layouts that can be achieved using up to 
ten QuadPlex devices. See “Sample Layouts” on page 36.

Standalone QuadPlex units include three buttons on the top of the unit, as shown and described in 
“Front Panel Controls and Indicators” on page 3. To use a button:

1. Press the desired button once.

An on-screen menu appears.

2. Press the button repeatedly to cycle through the menu until your desired selection is 
highlighted.

3. Release the button.

CHAPTER

3 OPERATION

3.1 Using the Buttons

No t e If LED B turns red, then the buttons are disabled. See “Device Management Tab” on 
page 35 for information on enabling/disabling buttons.
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The QuadPlex application simplifies configuring and creating wall designs for QuadPlex devices. 
This application works in offline mode to customize configurations of any type and size without 
needing an active connection to the QuadPlex device(s), including:

 Independently rotating each output in 90-degree increments (90, 180, and 270) for artistic 
video wall configurations.

 Using preset images to control and fine-tune bezel corrections to ensure seamless image 
displays.

 Optimize visuals by cropping, upscaling, or downscaling the content as desired.

Starting the QuadPlex application for the first time creates a new, blank design. A design contains 
both the devices in a video wall and their settings.

3.2.1 Interface
Figure 3-1 displays the QuadPlex application interface.

Figure 3-1   QuadPlex Application Interface

The numbered callouts in this figure depict the following components:

 Menus (1): The QuadPlex application contains three menus:

 File: Create, open, and close designs, and exit the QuadPlex application. See “Creating 
a New Design” on page 26, “Opening an Existing Design” on page 26, “Closing a 
Design” on page 27, and “Exiting the QuadPlex Application” on page 26.

3.2 Using the QuadPlex Application

1 2 3 4 5 6 7 8 9 10 11 12
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 Edit: Rename or delete a design. See “Renaming the Current Design” on page 27 and 
“Deleting a Design” on page 27.

 Help: Accesses online documentation for the QuadPlex application and provides 
application information.

 Add Device button (2): Clicking this button adds a virtual QuadPlex device to the current 
design. See “Adding a New Virtual Device” on page 28.

 Virtual device list (3): Lists the virtual QuadPlex device(s) in the current design. Selecting a 
device loads the saved layouts and configuration for that device. See “Working with Virtual 
Devices” on page 27.

 Layout tabs(4): Each tab corresponds to a different layout for the currently-selected device. 
Each device includes a number of default layouts. You can add, sort, and remove layouts. See 
“Managing Layouts” on page 28.

 Canvas (5): Displays the location and size of each output for the currently-selected layout, as 
well as a representation of the input image. You can move, rotate, and resize the four outputs 
as desired to configure the layout. See “Managing Layouts” on page 28.

 Displays (6): Each layout includes four displays that correspond to each of the four outputs on 
a QuadPlex unit. See “Managing Layouts” on page 28.

 Add Layout button (7): Clicking this button creates a new layout for the currently-selected 
device. See “Creating a New Layout” on page 29.

 Output settings tab (8): Allows you to specify the layout and configure displays for the 
currently-selected device. See “Output Settings Tab” on page 30.

 Input settings tab (9): Allows you to specify the input resolution, refresh rate, and copy 
protection settings for the device input. See “Input Settings Tab” on page 32.

 Network settings tab (10): Allows you to specify the network settings for the currently-
selected device. See “Network Settings Tab” on page 33.

 Device data transfer tab (11): Uploads the configuration from the selected virtual device to 
the selected physical QuadPlex device on the subnet or downloads the configuration from a 
physical device on the subnet to the selected virtual device in the QuadPlex application. See 
“Device Data Transfer Tab” on page 34.

 Device management tab (12): Configures various options for the currently-selected device. 
See “Device Management Tab” on page 35.

3.2.2 Overview
To create and configure a design:

1. Either create a new design or open an existing design. See “Working with Designs” on 
page 26.

2. If needed, add or remove QuadPlex devices from the design. These devices are virtual 
because their settings aren't directly linked to a physical device. See “Working with Virtual 
Devices” on page 27.

No t e
If you open an existing design, then the QuadPlex device(s) that are in that design will 
appear in the QuadPlex application. A new design will not have any QuadPlex devices until 
you add them.
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3. Configure each QuadPlex device using the Network settings and Device management tabs. 
See both of the following:

 “Network Settings Tab” on page 33

 “Device Management Tab” on page 35

4. Define one or more layouts for each QuadPlex device using any or all of the following:

 Canvas

 Output settings tab (see “Output Settings Tab” on page 30)

 Input settings tab (see “Input Settings Tab” on page 32)

5. For each QuadPlex device, specify the active layout, which is the layout that will be used by 
that device. See “Setting the Active Layout” on page 29.

6. Upload the device configurations from the appropriate virtual QuadPlex device(s) in the design 
to the appropriate physical QuadPlex device(s). See “Device Data Transfer Tab” on 
page 34.

3.2.3 Exiting the QuadPlex Application
To quit the QuadPlex application, select File>Quit.

3.2.4 Working with Designs
This section describes how to create, edit, and delete a design. QuadPlex automatically opens the 
last design when you restart the program and saves each change you make to a design.

C R E ATI N G A N E W  D E S I G N

To create a new design:

1. Select File>New design.

The New design window appears.

2. Enter a name for the new design in the New design field, and then click OK.

A new, blank design appears.

3. Begin adding devices, as described in “Adding a New Virtual Device” on page 28. The 
QuadPlex application saves your work in real time; there is no need to manually save your 
work.

OP E N I N G  A N  E X I S T I N G  D E S I GN

To open an existing design:

1. Select File>Open design.
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A window opens with a list of all existing designs.

2. Click the desired design to open it.

You may now continue working on the selected design from where you previously left off.

C L OS I N G A D E S IG N

Closing a design closes the current design and returns you to the previous design. To close the 
current design, select File>Close design.

R E N A M I N G T H E  C U R R E N T D E S I GN

To rename the current design:

1. Select Edit>Rename design.

The Rename design window appears.

2. Enter the new name for the this design in the New design field, and then click OK.

D E L E T IN G A D E S IG N

To delete a design:

1. If needed, open the design that you want to delete as described in “Opening an Existing 
Design” on page 26. Otherwise, you will delete the design that you currently have open.

2. Select Edit>Delete design.

A confirmation dialog appears.

3. Click Yes to confirm the deletion.

3.2.5 Working with Virtual Devices
This section explains how to select, add, rename, and remove virtual QuadPlex devices.

S E L E C T IN G A D E V IC E

To select a virtual QuadPlex device, click the desired device in the Device List. Selecting a virtual 
device opens the Layout tabs and populates the Output settings, Input settings, Network 
settings, and Device management tabs with the current configuration for that device. See:

 “Output Settings Tab” on page 30

 “Input Settings Tab” on page 32

 “Network Settings Tab” on page 33

 “Device Management Tab” on page 35
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A D D I N G  A N E W V I R T U A L D E V I C E

To add a new virtual QuadPlex device, click the Add Device button. The new virtual device 
appears in the Device List with the default name New Device.

Each new virtual QuadPlex device starts with the default number of layouts, each of which has its 
own Layout tab. You can add, edit, and remove layouts for a device, as described in “Managing 
Layouts” on page 28.

R E N A M I N G A V I R TU A L D E V I C E

To rename a virtual device:

1. Right-click the virtual QuadPlex device you want to rename, and then select Rename.

The Device Name field opens for editing.

2. Enter the new name for the virtual device in the field, and then press [ENTER]. 

D E L E T IN G A V I R T U A L D E V I C E

To delete a virtual device:

1. Right-click the virtual QuadPlex device you want to delete, and then select Delete.

A confirmation dialog appears.

2. Click Yes to confirm the deletion.

3.2.6 Managing Layouts
Selecting a virtual QuadPlex device in the Device List displays the layouts that have been created 
for the selected virtual device. Each layout defines the following:

 Displays that will be receiving video from the QuadPlex device (from one to four).

 Position of each output display relative to both the video input being provided to the QuadPlex 
device and the other output display(s).

 Size of each display.

 Orientation (0, 90, 180 or 270 degrees).

 Bezel correction.

To select a layout, click the corresponding Layout tab. If needed, you can click the arrows on 
either side of the tabs to scroll left or right. Once selected, you can work with a layout in two ways:

 By clicking and dragging/resizing a display on the Canvas.

 Entering configuration information in the Output settings and Input settings tabs. See 
“Output Settings Tab” on page 30 and “Input Settings Tab” on page 32.
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C R E ATI N G A N E W  LAY O U T

To create a new layout, click the Add Layout button. A new Layout tab appears with a generic 
name (such as Config 17). You may now rename the layout, as described below, or perform any 
other configuration operation.

R E N A M I N G A L AY OU T

To rename a layout:

1. Right-click the Layout tab for the layout you want to rename, and then select Rename.

The Layout Name field opens for editing.

Enter the new name for the layout in the field, and then press [ENTER]. 

D E L E T IN G A L AY O U T

To delete a layout:

1. Right-click the Layout tab for the layout you want to delete, and then select Delete.

A confirmation dialog appears.

2. Click Yes to confirm the deletion.

S E T TI N G  T H E  A C TI V E  L AY O U T

To select which layout is applied to your QuadPlex product when uploading a configuration, right-
click the desired Layout tab, and then select Set as active layout. The active layout is identified 
by a star next to the layout name.

3.2.7 Tabs
The QuadPlex application includes five tabs:

 Output settings: Configures the number of outputs, and the display mode, resolution, 
rotation, and bezel correction for each output. See “Output Settings Tab” on page 30.

 Input settings: Configures the input mode, resolution, and copy protection. See “Input 
Settings Tab” on page 32.

 Network settings: Configures the network settings for the device. See “Network Settings 
Tab” on page 33.

 Device data transfer: Allows you to transfer designs between the virtual devices in the 
QuadPlex application and the real devices on the network. See “Device Data Transfer Tab” 
on page 34.

 Device management: Allows you to view physical QuadPlex device status and manage 
settings in real time. See “Device Management Tab” on page 35.
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OU TP U T S E T T I N G S  TA B

The Output settings tab is where you 
configure the number of outputs to assign to a 
virtual QuadPlex device. Remember that output 
settings are defined on a per-device, per-layout 
basis, meaning that you must first select both of 
the following:

 The virtual device you want to configure 
(see “Working with Virtual Devices” on 
page 27).

 The layout you want to work on (see 
“Managing Layouts” on page 28).

You can then configure settings on a per-output 
basis. From top to bottom, this tab includes the 
following functions:

 Layout: This pull-down menu allows you to 
select a layout for the outputs on the 
selected virtual QuadPlex device. In 
genreral, you may either use a single 
physical QuadPlex device to create a video 
wall layout with up to four displays, or may 
use multiple physical QuadPlex devices to 
create larger layouts. See “Sample 
Layouts” on page 36 for some layout 
ideas. If you change the number of displays 
or the position or size of a display, then the 
Layout menu will automatically be set to 
Custom. 
 
Selecting Clone Landscape or Clone 
Portrait allows you to clone the input 
display to each of the output displays. See 
“Cloning the Input” on page 36 for more 
information.

 Output sub-tabs: There is one sub-tab for 
each QuadPlex device output. Select the 
output you want to work with by either 
selecting the desired sub-tab or clicking the 
desired display in the Canvas.

 Output: Checking this box enables the 
selected output for the current layout and 
vice-versa.

 Audio: Checking this checkbox allows you to hear audio on this output, if audio is part of the 
input signal. QuadPlex devices support a single audio input, but can play that audio on all 
outputs at the same time.

 Force display mode: Checking this checkbox forces the QuadPlex device to always use the 
selected display mode regardless of the monitor’s EDID settings. Clearing this checkbox 
causes the output to use the display mode closest to the mode selected according to the EDID 
settings of the monitor.
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 Display mode: Use this pull-down menu to select the resolution (in pixels) and refresh rate (in 
Hz) of your output. Selecting a different size (width and height) and/or aspect ratio (width/
height) of the source rectangle from the size and aspect ratio of the selected resolution will 
cause scaling to occur.

 Rotation: Select the rotation for the content of your output. Possible rotations are 90, 180, and 
270 degrees.

 Source rectangle: Define the coordinates (Top and Left) and size (Width and Height), in 
pixels, of the region of the canvas shown on this output. The source rectangle is always scaled 
to use the entire resolution (width and height) of the display mode. If the aspect ratio (width/
height) of the source rectangle differs from the aspect ratio of the display mode, then the video 
may appear stretched or squished.

You can also define the source rectangle of an output by moving and resizing the source 
rectangle of the output on the canvas with your mouse pointer.

 Bezel management: This function allows you to adjust the image to compensate for the 
physical space created by the bezels of your monitors, thereby creating an image that appears 
seamlessly across your monitors. For each border of your output (Left, Top, Right, and 
Bottom), enter the number of pixels that are hidden behind the physical space between your 
monitors to create a continuous image.

If desired, you can test bezel management values on the actual displays in real time. To do 
this:

a. From the Device data transfer tab, upload the configuration of your virtual device to the 
physical device on which you want to test your bezel management settings. 

b. Use the Device pull-down menu in the Output settings tab, and then toggle the Live 
switch to On (green). This adds a temporary virtual device to the current design with the 
same settings as the physical device.

c. Select the outputs in the current layout, and then modify their bezel management settings. 
Your changes will be visible in real time and will be automatically applied and saved to the 
physical QuadPlex device.

d.  Once your bezel management settings are properly set, toggle the Live button to Off 
(gray). This removes the temporary QuadPlex virtual device from your design and returns 
the interface to the previously-selected virtual QuadPlex device. To update the bezel man-
agement settings on this virtual device, download the configuration of your physical device 
to your virtual device, as described in “Device Data Transfer Tab” on page 34. 

No t e No other operations are supported in Live mode.
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I N P U T  S E T TI N G S  TA B

The Input settings tab is where you configure 
the input signal settings on the DisplayPort IN 
or HDMI IN connector of the selected QuadPlex 
device. Remember that input settings are 
defined on a per-device, per-layout basis, 
meaning that you must first select both of the 
following:

 The virtual device you want to configure 
(see “Working with Virtual Devices” on 
page 27).

 The layout you want to work on (see 
“Managing Layouts” on page 28).

From top to bottom, this tab includes the 
following functions:

 Input mode: This pull-down menu allows you to match the resolution and refresh rate used by 
your video source. Scaling may occur if the input mode is different from the actual input signal. 
Also, a mismatch between the selected input mode and the actual input signal will be indicated 
through the On Screen Display (OSD) of QuadPlex devices and via the LEDs on a standalone 
QuadPlex unit (see “Front Panel Controls and Indicators” on page 3).

 Width: Width of the input resolution, in pixels.

 Height: Height of the input resolution, in pixels.

 Refresh rate: Refresh rate of the input signal, in Hz.

 Enable copy protection: Check this checkbox if the video source plays copy-protected 
content.
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N E T WO R K  S E TT I N G S  TA B

The Network settings tab is where you 
configure the network parameters for a virtual  
QuadPlex device. Remember that network 
settings are defined on a per-device basis, 
meaning that you must first select the virtual 
device you want to configure (see “Working 
with Virtual Devices” on page 27).

From top to bottom, this tab includes the 
following functions:

 Obtain an IP address automatically: 
Check this radio button if you want the 
selected QuadPlex device to automatically 
obtain its IP address, subnet mask, and 
default gateway information from the DHCP 
network.

 Use the following IP address: Check this 
radio button if you want to manually assign 
the following parameters to the selected 
QuadPlex device:

 IP address

 Subnet mask

 Default gateway

 Obtain a DNS address automatically: Check this radio button to have the QuadPlex unit 
obtain the DNS address from the DHCP server.

 Use the following DNS address: Select this to manually enter the IP address of the DNS 
server in the Preferred DNS server field.

Consult your network administrator for assistance, if needed.

No t e
Remember that a QuadPlex PCIe card must have its own Ethernet connection and network 
configuration that is separate from that of the Galileo or Zio W4000 unit where that QuadPlex 
card is mounted.
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D E V I C E  D ATA T R A N S FE R  TA B

The Device data transfer tab is where you 
upload and download configurations to and 
from physical QuadPlex devices. When 
downloading or uploading configurations, the 
order of the layouts shown in the QuadPlex 
application will the order shown in the on-
screen layout selection menu on the physical 
QuadPlex devices.

A configuration consists of the following 
information:

 Layouts

 Output settings 

 Input settings 

 Network settings

From top to bottom, this tab includes the 
following functions:

 Search: Enter the serial number or IP 
address of a physical QuadPlex device and 
then either press [ENTER] or click the 
Search icon (magnifying glass) to locate 
the desired device in the list.

 Physical devices: List of physical 
QuadPlex devices on the network.

 Upload: Uploading replaces the 
configuration of a physical QuadPlex 
device with the configuration of a virtual 
QuadPlex device. To upload a configuration to a physical device, select a virtual QuadPlex 
device, then select a physical the physical device in the Device data transfer tab, and then 
click Upload.

 Download: Downloading replaces the configuration of a virtual QuadPlex device with the 
configuration of a physical QuadPlex device. To download a configuration from a physical 
device, select a virtual QuadPlex device, then select a physical device in the Device data 
transfer tab, and then click . The name of the virtual device changes to match the name of the 
physical device from which you downloaded the configuration.

 Device information: Hovering the mouse cursor over a QuadPlex device in the Physical 
devices list displays the following information for that device:

 Model number: Model number of that QuadPlex device. 

 Serial number: Serial number of that QuadPlex device. 

 IP address: IP address of that QuadPlex device 

 MAC address: Unique physical address of the network connector on that QuadPlex 
device. 
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 Firmware version: Version of the firmware package installed on that QuadPlex device. 

D E V I C E  M A N A G E M E N T  TA B

The Device managent tab is where you view 
the status and manage the settings of the 
physical QuadPlex devices on the subnet. The 
settings on this tab update the selected 
physical QuadPlex devices in real time; you 
need not use the Device data transfer tab to 
have these settings take effect.

From top to bottom, this tab includes the 
following functions:

 Device: Use this pull-down menu to select 
the physical QuadPlex device you want to 
manage.

 Input source: Use this pull-down menu to 
select the desired input source. This is the 
same as pressing the Source Selection 
button on a standalone QuadPlex unit. See 
the following:

 Standalone QuadPlex unit: “Front 
Panel Controls and Indicators” on 
page 3.

 QuadPlex PCIe card: “Connectors 
and Indicators” on page 6.

Select your desired input source, and then 
click Apply.

 Display info: Clicking the Show/Hide button toggles showing or hiding the physical QuadPlex 
devices information on the display. This is the same as pressing the Device Information 
button on a standalone QuadPlex unit. See “Front Panel Controls and Indicators” on 
page 3.

 Locate: Clicking the Start/Stop button toggles flashing LED A on a standalone QuadPlex 
device on and off to help you find that device among multiple devices, such as on a rack. The 
Device information area (see below) will show this device is in locating mode. LED A will keep 
blinking until you click Stop.

 Lock buttons: Clicking Lock/Unlock toggles locking the buttons on a standalone QuadPlex 
unit. When button locking is enabled, LED B will illuminate solid red as long as a button is 
being pressed.

 Device information: This area of the screen displays information about the selected physical 
QuadPlex device, including status. You can copy the device information to your clipboard, if 
desired.
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3.2.8 Cloning the Input
In the Output Settings tab (see “Output Settings Tab” on page 30), selecting Clone Landscape 
or Clone Portrait in the Layout menu clones the input display to the output displays, meaning that 
the entire content of the input display appears on each of the output displays, as shown in 
Figure 3-2. 

Figure 3-2   Cloning Example

When cloning the input:

 Selecting Clone Landscape orients the outputs horizontally. This may cause the output 
streams to appear sideways, depending on the orientation of the input stream.

 Selecting Clone Portrait orients the outputs vertically. This may cause the output streams to 
appear sideways, depending on the origination of the input stream.

 The QuadPlex device will automatically downsample a 4K input stream to 1080p and will 
directly pass through a 1080p input stream.

 You may perform any adjustment on any output display (such as display mode, rotation, 
source rectangle, and bezel management) regardless of cloning.

Table 3-1 lists many common layouts that can be achieved using one or more QuadPlex unit(s). 
The columns in this table provide the following information:

 Layout: Layout arrangement in rows x columns of displays. For example, the notation 3 x 2 
indicates three (3) rows and two (2) columns of displays. Each layout includes one row for 
each QuadPlex unit that is required to create that layout. In this example, each 3 x 2 layout 
requires two QuadPlex units, and thus each 3 x 2 layout includes two rows.

 Input: Resolution of each input. Layouts that require multiple QuadPlex units will list the input 
for each QuadPlex unit on a separate row.

3.3 Sample Layouts

/

4k @ 60Hz

1080p @ 60Hz

1080p @ 60Hz

1080p @ 60Hz

1080p @ 60Hz
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 QuadPlex: QuadPlex unit number. Each layout includes one row for each QuadPlex unit that 
is required to create that layout. This column also includes a colored square that corresponds 
to the visual depiction of that unit’s outputs are arranged in the layout shown in the Layout 
column. The notation direct indicates that a video source connects directly to a display without 
passing through a QuadPlex unit.

 Outputs: Number of HD displays that are connected to each QuadPlex output.

 Layout: Visual depiction of each layout. Each colored square corresponds to a single HD 
display connected to a QuadPlex unit. The color of each square corresponds to the QuadPlex 
unit that is driving that display. For example, the first 6 x 1 layout shows three displays being 
driven by QuadPlex Unit 1 and three displays being driven by QuadPlex Unit 2. The second 6 
x 1 layout shows four displays being driven by QuadPlex Unit 1 and two by QuadPlex Unit 2.

No t e
Table 3-1 lists many commonly-used layouts, but this list is far from complete because is 
impossible to list all of the possible QuadPlex layouts. If you need to create a layout that is 
not in this list, then contact RGB Spectrum Technical Support for assistance. See “Technical 
Support” on page 51.

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout

x1 Layouts

2 x 1 3840 x 1080 Unit 1 2
3 x 1 5760 x 1080 Unit 1 3
4 x 1 7860 x 1080 Unit 1 4
5 x 1 7860 x 1080 Unit 1 4

1920 x 1080 direct 1
6 x 1 5760 x 1080 Unit 1 3

5760 x 1080 Unit 2 3
6 x 1 7860 x 1080 Unit 1 4

3840 x 1080 Unit 2 2

x2 Layouts

1 x 2 1920 x 2160 Unit 1 2

2 x 2 3840 x 2160 Unit 1 4

3 x 2 5760 x 1080 Unit 1 3
5760 x 1080 Unit 2 3

3 x 2 3840 x 2160 Unit 1 4
1920 x 2160 Unit 2 2

4 x 2 7860 x 1080 Unit 1 4
7860 x 1080 Unit 2 4

4 x 2 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
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5 x 2 7860 x 1080 Unit 1 4
7860 x 1080 Unit 2 4
1920 x 2160 Unit 3 2

5 x 2 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
1920 x 2160 Unit 3 2

6 x 2 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4

x3 Layouts

1 x 3 1920 x 3240 Unit 1 3

2 x 3 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3

2 x 3 3840 x 2160 Unit 1 4
3840 x 1080 Unit 2 2

3 x 3 5760 x 1080 Unit 1 3
5760 x 1080 Unit 2 3
5760 x 1080 Unit 3 3

3 x 3 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3
1920 x 3240 Unit 3 3

4 x 3 7860 x 1080 Unit 1 4
7860 x 1080 Unit 2 4
7860 x 1080 Unit 3 4

4 x 3 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
7860 x 1080 Unit 3 4

5 x 3 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3
1920 x 3240 Unit 3 3
1920 x 3240 Unit 4 3
1920 x 3240 Unit 5 3

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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5 x 3 7860 x 1080 Unit 1 4
7860 x 1080 Unit 2 4
7860 x 1080 Unit 3 4
1920 x 3240 Unit 4 3

5 x 3 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
7860 x 1090 Unit 3 4
1920 x 3240 Unit 4 3

6 x 3 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3
1920 x 3240 Unit 3 3
1920 x 3240 Unit 4 3
1920 x 3240 Unit 5 3
1920 x 3240 Unit 6 3

6 x 3 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
5760 x 1080 Unit 4 3
5760 x 1080 Unit 5 3

6 x 3 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
7860 x 1080 Unit 4 3
3840 x 1080 Unit 5 2

6 x 3 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 1080 Unit 5 2

x4 Layouts

1 x 4 1920 x 4320 Unit 1 4

2 x 4 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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2 x 4 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4

3 x 4 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4

3 x 4 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
1920 x 4320 Unit 3 4

4 x 4 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4

4 x 4 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4

4 x 4 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4

5 x 4 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4
1920 x 4320 Unit 5 4

5 x 4 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4
1920 x 4320 Unit 5 4

5 x 4 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
1920 x 4320 Unit 5 4

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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6 x 4 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4
1920 x 4320 Unit 5 4
1920 x 4320 Unit 6 4

6 x 4 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4

6 x 4 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4
1920 x 4320 Unit 5 4
1920 x 4320 Unit 6 4

6 x 4 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4

x5 Layouts

2 x 5 3840 x 1080 Unit 1 2
3840 x 1080 Unit 2 2
3840 x 1080 Unit 3 2
3840 x 1080 Unit 4 2
3840 x 1080 Unit 5 2

2 x 5 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 1080 Unit 3 2

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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2 x 5 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
3840 x 1080 Unit 3 2

3 x 5 5760 x 1080 Unit 1 3
5760 x 1080 Unit 2 3
5760 x 1080 Unit 3 3
5760 x 1080 Unit 4 3
5760 x 1080 Unit 5 3

3 x 5 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
5760 x 1080 Unit 4 3

3 x 5 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
1920 x 4320 Unit 3 4
5760 x 1080 Unit 4 3

4 x 5 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4
7680 x 1080 Unit 5 4

4 x 5 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
7680 x 1080 Unit 5 4

4 x 5 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4
7680 x 1080 Unit 5 4

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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5 x 5 7680 x 1080 Unit 1 4
7680 x 1080 Unit 2 4
7680 x 1080 Unit 3 4
7680 x 1080 Unit 4 4
7680 x 1080 Unit 5 4
1920 x 4320 Unit 6 4
1920 x 1080 direct 1

5 x 5 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4
1920 x 4320 Unit 5 4
7680 x 1080 Unit 6 4
1920 x 1080 direct 1

5 x 5 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
1920 x 4320 Unit 5 4
7680 x 1080 Unit 6 4
1920 x 1080 direct 1

6 x 5 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4
5760 x 1080 Unit 7 3
5760 x 1080 Unit 8 3

6 x 5 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
1920 x 4320 Unit 3 4
1920 x 4320 Unit 4 4
1920 x 4320 Unit 5 4
1920 x 4320 Unit 6 4
5760 x 1080 Unit 7 3
5760 x 1080 Unit 8 3

x6 Layouts

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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2 x 6 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4

2 x 6 1920 x 4320 Unit 1 4
1920 x 4320 Unit 2 4
3840 x 2160 Unit 3 4

3 x 6 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3
1920 x 3240 Unit 3 3
1920 x 3240 Unit 4 3
1920 x 3240 Unit 5 3
1920 x 3240 Unit 6 3

3 x 6 5760 x 1080 Unit 1 3
5760 x 1080 Unit 2 3
5760 x 1080 Unit 3 3
5760 x 1080 Unit 4 3
5760 x 1080 Unit 5 3
5760 x 1080 Unit 6 3

3 x 6 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
1920 x 3240 Unit 4 3
1920 x 3240 Unit 5 3

4 x 6 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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5 x 6 1920 x 3240 Unit 1 3
1920 x 3240 Unit 2 3
1920 x 3240 Unit 3 3
1920 x 3240 Unit 4 3
1920 x 3240 Unit 5 3
1920 x 3240 Unit 6 3
1920 x 3240 Unit 7 3
1920 x 3240 Unit 8 3
1920 x 3240 Unit 9 3
1920 x 3240 Unit 10 3

5 x 6 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4
1920 x 3240 Unit 7 3
1920 x 3240 Unit 8 3

6 x 6 3840 x 2160 Unit 1 4
3840 x 2160 Unit 2 4
3840 x 2160 Unit 3 4
3840 x 2160 Unit 4 4
3840 x 2160 Unit 5 4
3840 x 2160 Unit 6 4
3840 x 2160 Unit 7 4
3840 x 2160 Unit 8 4
3840 x 2160 Unit 9 4

Table 3-1   QuadPlex Layouts

Layout Input QuadPlex # Outputs Layout
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3.3.1 Calculating a Custom Layout
The following formula will help you calculate the numberof QuadPlex devices needed for any given 
layout:

(# of displays ¸ 4 outputs/device) + remainder if any

For example, a 2x7 video wall has 14 displays. Dividing 14 by the 4 outlets per QuadPlex device 
yields 3 plus a remainder of 2. You therefore need four (4) QuadPlex devices, where either:

 Option A:

 Three QuadPlex devices will have displays connected to all 4 outputs.

 One QuadPlex device will have displays connected to 2 outputs.

 Option B:

 Two QuadPlex devices will have displays connected to all 4 outputs.

 One QuadPlex device will have displays connected to 3 outputs.

By contrast, a 2x10 layout has 20 displays. Dividing 20 by the 4 outlets per QuadPlex device yields 
5 with no remainder. All five QuadPlex devices in this layout will have displays connected to all 4 
ports.

If there an even number of both rows and columns, then there will never be a remainder, and every 
QuadPlex device will have all four outlets in use.
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RGB Spectrum periodically updates product firmware to add new features or improve product 
performance. To check for firmware updates for your RGB Spectrum product:

1. Visit the Partner Portal section of our web site at http://www.rgb.com/partners/.

2. Either:

 Click the Login button to access the portal with an existing username and password.

 Create a new account by clicking the Register button and then following the on-screen 
instructions.

3. After logging in to the portal, select Product Firmware. 

4. To determine your current firmware version number, either:

 In the QuadPlex application, hover your mouse cursor over the desired QuadPlex device 
to open a pop-up with device information that includes the firmware version.

 At the QuadHead device, press the Device Information button once to open the on-
screen menu, then look for the Firmware Version on the screen.

5. Download the new QuadPlex firmware to the remote PC where you have the QuadView 
application installed, and then extract it to a folder on that system (such as C:\QuadPlexFW). 
The remote PC must have at least 1 GB of available disk space.

6. If needed, download the QuadPlex firmware utility to the remote PC where you have the 
QuadView application installed, and install the updater utility by double-clicking it and then 
following the on-screen instructions.

7. Proceed to “Before Updating the Firmware” on page 48.

CHAPTER

4 FIRMWARE 
UPDATES

http://www.rgb.com/partners/
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Before updating your QuadPlex firmware:

 The firmware update process requires the QuadPlex device to reboot at least once. Make sure 
you are running the QuadPlex devices and the QuadPlex Firmware Updater on an established 
network that includes a Dynamic Host Configuration Protocol (DHCP) server that will assign 
the same IP address to each device as it reappears on the network. Alternatively, consult your 
network administrator to assign fixed IP addresses to your QuadPlex devices.

 If your system does not have access to a Domain Name Service (DNS) server, then configure 
your system to use a fixed IP address (such as local host – 127.0.0.1) as the DNS server. 
Otherwise, the firmware update process may take a long time to complete.

 Be sure to only run one instance of the QuadPlex Firmware Updater on your network at a time, 
to avoid potential conflicts with QuadPlex devices.

To update the firmware on your QuadPlex devices:

1. On the remote PC, navigate to the folder 
containing the QuadPlex Firmware 
Updater, and then launch the application.

The 1 - Search for devices window 
appears.

2. Either:

 Check the Automatic detection radio 
button to have the updater search for 
all QuadPlex devices on the same 
subnet as the remote PC.

 Check the Manual detection radio 
button, then enter the IP address(es) of 
each QuadPlex device you want to 
locate in the Address or URL field. 
You may enter multiple IP addresses 
by separating each address with a 
space (e.g. 192.168.1.100 
192.168.1.101 192.168.1.102).

 Check the Manual detection button, 
then click the Browse button (three 
dots) next to the Address or URL field, 
and then enter the IP addresses of your 
QuadPlex devices. Place each IP 
address on a separate line by pressing 
[ENTER] after each IP address, and 
then click Apply when finished. 

4.1 Before Updating the Firmware

4.2 Updating the Firmware
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3. Click Search to begin searching for devices, either automatically or using the IP address(es) 
you supplied in Step 2.

 If needed, you can pause the search by clicking Stop.

 You can restart paused searches by clicking Search again.

The system returns a list of discovered QuadPlex devices.

4. Select the devices you want to update. During device selection, you may:

 Change the sort order of the device tiles by right-clicking the device list box, selecting Sort 
by, and then selecting the sorting order to use.

 Deselect all devices by right-clicking the device list box, and then selecting Unselect all 
devices.

5. Click Update.
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RGB Spectrum 
950 Marina Village Parkway 
Alameda, CA 94501

Phone: +1-510-814-7000

Fax: +1-510-814-7026

Web: rgb.com

Web: rgb.com/contact

Phone: +1-510-814-7000, option 3

Email: tech@rgb.com

Phone: +1-510-814-7000, option 1

Web: rgb.com/support

CHAPTER

5 CONTACT 
INFORMATION

5.1 Corporate Headquarters

5.2 Sales and Product Information

5.3 Technical Support

http://www.rgb.com
http://www.rgb.com/support
mailto:tech@rgb.com
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	Mounting a QuadPlex Standalone Unit
	2.1.1 Rack Mount
	Figure 2-1 Rack Mounting Shelf
	1. Fasten the shelf to the rack in accordance with the instructions for your rack. The shelf includes screws that are compatible with most rack mounts. If needed (such as for clearance), you may mount the QuadPlex unit(s) first, and then mount the sh...
	2. Remove the four (4) rubber pads at the bottom of each QuadPlex unit that you are going to mount.
	3. On the rack mounting shelf, locate the three sets of mounting holes labeled M/M. These holes are 2” (5.08 cm) from the front edge of the mounting shelf.
	4. Place the first QuadPlex unit on the rack mounting shelf, being sure to line the mounting holes on the bottom of the casing with one of the sets of holes labeled M/M.
	5. Secure the QuadPlex unit to the rack mounting shelf using two (2) M3 x 6 flat-head screws (included in the rack mounting kit) and a hand screwdriver. Do not over-tighten the screws.
	6. Repeat Steps 3-5 for up to two (2) more QuadPlex units.
	7. Connect the input, output, network, and power cables to the mounted unit(s), as described in “Connections (Standalone Unit)” on page 14.
	1. Fasten the shelf to the rack in accordance with the instructions for your rack. The shelf includes screws that are compatible with most rack mounts. If needed (such as for clearance), you may mount the QuadPlex unit(s) first, and then mount the sh...
	2. On the rack mounting shelf, locate the 10 sets of mounting holes labeled M. These holes are 1.25” (3.18 cm) from the front edge of the mounting shelf.
	3. Place the first QuadPlex unit on the rack mounting shelf, being sure to line the mounting holes on the side of the casing with one of the sets of holes labeled M.
	4. Secure the QuadPlex unit to the rack mounting shelf using two (2) M3 x 6 flat-head screws (included in the rack mounting kit) and a hand screwdriver. Do not over-tighten the screws.
	5. Repeat Steps 3-5 for up to nine (9) more QuadPlex units.
	6. Connect the input, output, network, and power cables to the mounted unit(s), as described in “Connections (Standalone Unit)” on page 14.


	2.1.2 VESA Mount
	1. Attach the brackets to the VESA mount using two (2) M4 screws (sold separately) inserted through a slot in each bracket, as shown in Figure 2-2. Do not over-tighten.
	2. Use four (4) M3 x 6 flat-head screws (included in your kit) to attach the QuadPlex unit to the brackets. Do not over-tighten.
	Figure 2-2 75 or 100 mm VESA Mount
	1. Use four (4) M3 x 6 flat-head screws (included in your kit) to attach the QuadPlex unit to the brackets with the angles facing away from each other, as shown in Figure 2-3. Do not over-tighten.
	2. Attach the brackets to the VESA mount using two (2) M4 screws (sold separately) inserted through a slot in each bracket. Do not over-tighten.

	Figure 2-3 200 mm VESA Mount
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	Figure 2-7 Securing the HDMI Cables - Standalone
	1. Fasten two screw post extenders (1) to the threaded holes on either side of the HDMI OUT ports.
	2. Place the QPX BRK-4H HDMI cable bracket (2) over HDMI the cables, and then slide it toward the QuadPlex unit until it touches the screw post extenders.
	3. Secure each end of the QPX BRK-4H HDMI cable bracket to the screw post extenders using two (2) 2 9/16” (6.51 cm) screw posts. Do not use 1 15/16” (4.92 cm) screw posts.
	4. If you are using an HDMI standlone QuadPlex unit (p/n QPX HIN), then secure the HDMI input cable to the port using a single screw post extender (1), QPX BRK- 1H (2), and a single 2 9/16” screw post (3).

	Figure 2-8 Securing the HDMI Input - Standalone
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	2.3.3 (Optional) Securing the Cables - PCIe
	Figure 2-14 Securing the Cables - PCIe
	1. Fasten a single screw post extender to each of the five threaded holes on the card next to each input/output port.
	2. Place a QPX BRK-1H cable bracket over a cable, and then slide it toward the QuadPlex PICe card until it touches the screw post extender.
	3. Secure the bracket to the screw post extender using a single 2 9/16” (6.51 cm) screw post. Do not use a 1 15/16” (4.92 cm) screw post.
	4. Repeat Steps 2-4 for the remaining cables that are connected to the QuadPlex PCIe card.


	2.3.4 Connecting to a Network
	Figure 2-15 Ethernet Connection - PCIe Card
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	2.4.1 Standalone Unit
	1. Turn on your output display(s).
	2. Turn on the video source component.
	3. Plug the female end of the supplied power cord into the AC power inlet at the rear of the QuadPlex (AC 100V ~ 240V).
	4. Connect the other end to an AC power source.

	2.4.2 PCIe Card
	1. Turn on your output display(s).
	2. Turn on the video source component.
	3. Turn on the Galileo or Zio W4000 device that contains the QuadPlex card(s) and wait for the device to boot.
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	1. Connect and power on your QuadPlex devices, and then verify that all devices have been discovered by the network. If needed, contact your network administrator for help.
	2. Verify that all of the QuadPlex devices can by reached from the remote PC by opening a command prompt and then executing a ping <device_ip_address> command for each QuadPlex device, where <device_ip_address> is the IP address of either a standalon...
	3. Either download the QuadPlex.msi installer to the remote PC or insert a drive containing this file into the remote PC.
	4. Double-click the installer icon.
	5. Click Next.
	6. Read the license, then check the I accept the terms... checkbox, and then click Next.
	7. Decide whether or not to create a desktop shortcut for the application by either checking or clearing the Do you want to create a Desktop shortcut? radio button, and then either:
	8. Either:
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	1. Press the desired button once.
	2. Press the button repeatedly to cycle through the menu until your desired selection is highlighted.
	3. Release the button.
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	3.2.1 Interface
	Figure 3-1 QuadPlex Application Interface

	3.2.2 Overview
	1. Either create a new design or open an existing design. See “Working with Designs” on page 26.
	2. If needed, add or remove QuadPlex devices from the design. These devices are virtual because their settings aren't directly linked to a physical device. See “Working with Virtual Devices” on page 27.
	3. Configure each QuadPlex device using the Network settings and Device management tabs. See both of the following:
	4. Define one or more layouts for each QuadPlex device using any or all of the following:
	5. For each QuadPlex device, specify the active layout, which is the layout that will be used by that device. See “Setting the Active Layout” on page 29.
	6. Upload the device configurations from the appropriate virtual QuadPlex device(s) in the design to the appropriate physical QuadPlex device(s). See “Device Data Transfer Tab” on page 34.

	3.2.3 Exiting the QuadPlex Application
	3.2.4 Working with Designs
	1. Select File>New design.
	2. Enter a name for the new design in the New design field, and then click OK.
	3. Begin adding devices, as described in “Adding a New Virtual Device” on page 28. The QuadPlex application saves your work in real time; there is no need to manually save your work.
	1. Select File>Open design.
	2. Click the desired design to open it.
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	2. Enter the new name for the this design in the New design field, and then click OK.
	1. If needed, open the design that you want to delete as described in “Opening an Existing Design” on page 26. Otherwise, you will delete the design that you currently have open.
	2. Select Edit>Delete design.
	3. Click Yes to confirm the deletion.

	3.2.5 Working with Virtual Devices
	1. Right-click the virtual QuadPlex device you want to rename, and then select Rename.
	2. Enter the new name for the virtual device in the field, and then press [ENTER].
	1. Right-click the virtual QuadPlex device you want to delete, and then select Delete.
	2. Click Yes to confirm the deletion.
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	1. Right-click the Layout tab for the layout you want to rename, and then select Rename.
	1. Right-click the Layout tab for the layout you want to delete, and then select Delete.
	2. Click Yes to confirm the deletion.

	3.2.7 Tabs
	a. From the Device data transfer tab, upload the configuration of your virtual device to the physical device on which you want to test your bezel management settings.
	b. Use the Device pull-down menu in the Output settings tab, and then toggle the Live switch to On (green). This adds a temporary virtual device to the current design with the same settings as the physical device.
	c. Select the outputs in the current layout, and then modify their bezel management settings. Your changes will be visible in real time and will be automatically applied and saved to the physical QuadPlex device.
	d. Once your bezel management settings are properly set, toggle the Live button to Off (gray). This removes the temporary QuadPlex virtual device from your design and returns the interface to the previously-selected virtual QuadPlex device. To update...
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	1. Visit the Partner Portal section of our web site at http://www.rgb.com/partners/.
	2. Either:
	3. After logging in to the portal, select Product Firmware.
	4. To determine your current firmware version number, either:
	5. Download the new QuadPlex firmware to the remote PC where you have the QuadView application installed, and then extract it to a folder on that system (such as C:\QuadPlexFW). The remote PC must have at least 1 GB of available disk space.
	6. If needed, download the QuadPlex firmware utility to the remote PC where you have the QuadView application installed, and install the updater utility by double-clicking it and then following the on-screen instructions.
	7. Proceed to “Before Updating the Firmware” on page 48.
	Before Updating the Firmware
	Updating the Firmware
	1. On the remote PC, navigate to the folder containing the QuadPlex Firmware Updater, and then launch the application.
	2. Either:
	3. Click Search to begin searching for devices, either automatically or using the IP address(es) you supplied in Step 2.
	4. Select the devices you want to update. During device selection, you may:
	5. Click Update.
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